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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and
get a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorized personnel. Failure to
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follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

e In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de l'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de l'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer |'automate M-Duino dans un boftier, une armoire ou une salle de
contrdle électrique. L'acces au boftier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

e En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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INDUSTRIAL SHIELDS

1 General Description M-Duino 38AR 1/0s PLUS Product

1.1  Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and B the shield from above.

Bl ——— — .
Y 7
B 2= -
ga ‘EF
= = i |
FE Y- L
wow w oW w
Zzz zZz2
[o)Ne] (el elNe]
N N N NN
o O = O o<
CZONE
. 1, BZONE

(. om=h.y' AZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Outputs are named as Q1.X and relays as R1.X
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1.2 Zone Distribution

Communication

The distribution of the different features that provide the M-Duino 38AR 1/Os PLUS is

the following one:

Rev. 1: 12-08-2020

~ e -
ZONE C
J . /
—»{ Analog ‘ Relay

Y

Digital

Shield B Zone C Zone
13 Inputs
(13 Digital inputs, 6
of which can work
as Analog Input)
Analog Shield
8 Outputs
(8 Digital Outputs, 3
of which can work
as Analog Output)
6 Inputs
(6 Digital Inputs,
4 of which can work
as Analog Input)
Relay Shield 11 Qutputs
(8 Relay Outputs,
3 Digital Outputs,
3 of which can work
as Analog Output)

11
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1.3 A Zone Features

Shield A Zone

(1x) Ethernet
(1x) USB
(1x) 12C
o (2x) TTL
Comrsnrllj_nllgatlon (1x) RS-232
e (1x) HALF/FULL Duplex RS-485
(1x) SPI external Port
(1x) RTC
(1x) uSD Socket

1.4  Mechanical dimension

T = — — o —

i
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1.5 General Features

CONECTABLE PLC ARDUINO 24 VCC M-DUINO

GRPS/GSM Controller General .
MODEL TYPE e Information
Specifications
Fuse Protection (2.5 A) Polarity
Input Voltage 12 t0 24 Vdc protection
| max. 15A
Size 101x94.7x119.5
Clock Speed 16 MHz
Flash Memory 256 KB of which 8 KB used by boot loader
SRAM 8 KB
EEPROM 4 KB
. . 12C — Ethernet Port — USB — GPRS — RS485 — RS232 — SPI MAX232 — MAX485 — W5500 —
Communications — (2x) RX, TX (Arduino pins) Sim800L
. . Only meant for uploading or debugging, NOT ALWAYS Cannot be working in a final
USB Consideration! connected as a serial in a project! application
i i Oto10V
An/Dig Input 10 bits Input Impedance: 39K
(0-10 Vce) Separated PCB ground
.. 510 24 Vdc
Digital Isolated Input I min: 2 to 12 mA
(24 VCC) Galvanic Isolation
510 24 Vdc
*Interrupt Isolated Input Hs I min: 2 to 12 mA
(24 VCC) Galvanic Isolation
. 0to 10 Vdc
Analog Output 8 bits | max: 20 mA
(0 —-10 VCC) Separated PCB Ground
5to0 24 Vdc
Digital Isolated Output kS (U
Galvanic Isolation | 24 Vdc: 410 mA
(24 Vcce) Diode Protected for Relay LS = m
24 VDC / 220 VAC
. I max: 5 A
Digital Isolated Output Galvanic. Isolation
(Relay) Diode Protected for Relay

13
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5to0 24 Vdc
PWM Isolated Output 8 bits o | [OEEE gD
alvanic Isolation
(24 Vcce) Diode Protected for Relay
Expandability 12C — 127 elements — Serial Port RS232 / RS485 / GPRS

*By using this type of signal can no longer use Digital signal (24 Vdc)

14
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2 Technical Specifications:

2.1

General Specifications:

Item

M-Duino PLC Arduino Ethernet 38AR I/Os Analog/Digital PLUS

Power supply

voltage DC power supply

12 to 24Vdc _—=

Operating

voltage range DC power supply

11.4t025.4Vdc ===

Power
consumption DC power supply 30VAC max.
Power supply 2avde ===
External voltage
power supply Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 4889 max.
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2.2  Performance Specification:

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/lHomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the boot loader

Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz
Clock Speed 16MHz
2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino
Ethernet 38AR I/Os Analog/Digital PLUS:

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / , . :
S ; . Indicates that the equipment is
- . . Grar;hlcal symbols 5031/ Direct suitable for direct current only;
or use on Current to identify relevant terminals
equipment
IEC 60417/ Indicates that the equipment is
Graphical symbols . suitable for alternating current
TN for use on 5032 c/:AIternatmg only; to identify relevant
: urrent ,
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the_control by
for use on which a pulse is started.
, General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground . C :
equipment 5019 is explicily required.
IEC 60417 / : . ,
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Signal lamp . .
; lamp(s) is (are) switched on or
equipment off

16
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Medical Devices CE marking indicates that a
Directive CE Marking product complies with
93/42/EEC applicable European Union
regulations
ISO 7000/ . .
Graphical symbols Indlcates_a p(_)tentlal_ly _
for use on 0434B / hazardous situation which, if
equibment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Gragg:clil;:)grgbols 5036 / Dangerous To indicate hazards arising
equipment Voltage from dangerous voltages

3 Precautions

Read this manual before attempting to use the ETHERNET 38AR |/Os ANALOG/DIGITAL PLUS
PLC and follow its descriptions for reference during operation.

3.1  Arduino Board

The MDUINO PLC ARDUINO ETHERNET BLE 38AR 1/Os ANALOG/DIGITAL PLUS includes an
Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using the M-DUINO PLC ARDUINO ETHERNET 38AR 1/0Os ANALOG / DIGITAL PLUS under
different conditions from what has been specified in this manual or integrating into nuclear
control systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of the M-Duino are sufficient for the systems, machines, and equipment, and be
sure to provide the systems, machines, and equipment double safety mechanisms. This
manual provides information for programming and operating the M-DUINO.

17
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4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences x

Settings Networl:

Sketchbook lacation:

C:\Users\Albert\Documents\Arduino Browse
Editor language: English (English) | (requires restart of Arduino)
Editor font size: 15

Interface scale: Automatic | 100 - %  (requires restart of Arduino)

Show verbose output during: [+] compilation upload
Compiler warnings: Mone

[CJisplay line numbers

[[]Enable Code Folding

Werify code after upload

[ Use external editor

Check for updates on startup

Update sketch files to new extension on save (pde -> .ina)
Save when verifying or uploading

Additional Boards Manager URLs: |http://apps. industrialshields.com/main/arduino/boards fpackage_industrialshields_inde:| [

More preferences can be edited directly in the file
C:1\Users\Albert\AppData\ocal\Arduinal S\preferences. txt
(edit only when Arduing is not running)

OK Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

18


http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

Ref. IS.MDUINO.38AR+

4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch mar16a | Arduino 180

File Edit Skewh Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Sertal Plotter

WFi101 Finmware Updater

Board: "M-Duino family”

Inchusirial Shaelcls: "M-Duino 58+

Port
Get Board Info

) Programmer: “Ardhino as ISP’
Burn Bootioader

“ws
|

5. Search for

- _
M

Baards Manager...
Arduino AVR Boards

Asdhuino Yiin

Arduino/Genin Uno

Arduino Duemilanove or Diecimila
Arduine Nano

Arcuino/Gerano Mega o Mega 2560
Arduin Mega ADK

Arduing Leonardo

Arduina Leonardo ETH
Arduino/Genuine Micro

Arduino Esplora

Arduino Mini

Arduina Ethernet

Arcuina Fio

Arduino BT

LilyPad Archuino USB

LilyPad Arduino

Arduine Pro of Pro Min

Arduing NG or older
Arduino Robot Control

Arduing Robot Motor

Arduino Gemma

Adatruit Cireuit Playground
Arduing Yuin Mini
Arduina Incustrial 101
Linina One
Arching Uno Wikl
Incustial §
Ardbox tamily

* M-Duino family

ndustrialshields” on the browser.

Rev. 1: 12-08-2020

& Boards Manager

Type All ~ | |industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

~ Install

Close

19



Ref. IS.MDUINO.38AR+ Rev. 1: 12-08-2020

6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

© sketch_aug22a | Arduing 189 - o x
ch Tools Help

Auto Format cutsT
Archive Sketch
Fix Encoding & Reload

L Manage Libraries. CtrioShiftel
Serial Monitor CurleShifteM
Serial Plotter Ctri+Shift+L

WIFi101 / WIFININA Firmware Updater

Board: “M-Duino family" 3 Boards Manager
Model: "M-Duino 19R° a
i M5Stack-FIRE

Get Board Info MsStick-C

'ODROID ESP32

Heltec WiFi Kit 32

Heltec WiFi LoRa 32

Heltec WiFi LoRa 320v2)

Heltec Wireless Stick

ESPectro32
Microduino-Core£SP32

ALKS ESP32

WiPy 30

BPI-BIT

Silicognition wESP32

T-Beam

D-duino-32

LoPy

Lopy4

OROCA EduBot

ESP32 FM DevKit

Frog Board E5P32

Al Thinker ESP32-CAM

SparkFun LoRa Gateway 1-Channel

Programmer. *Arduino Gemma"
Bum Boatioader

WiFi module

Ardbox family
Ardbox GPRS family
Ardbox WIFi/BT family
[ M-Duino famity

M-Duino GPRS family
M-Duino WiFi/BT family

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools:

There, it can be selected the exact model for every family. In this case M-Duino 38AR+.

© sketch_aug23a | Arduina 189 - o %
File Edit Sketch Toals Help

Auto Format culsT
Archive Sketch
Fix Encoding & Reload

Manage Libraries._. CtrleShifts] =
Serial Monitor Curi=Shift+M
Serial Plotter Curl=Shift+L

WIFIT01 / WIFININA Firmware Updater

Board: “M-Duino family
Maodel. “M-Duino 38AR+" 3 M-Duing 19R
M-Duina 21
o M-Duino 21+

* M-Duino 38AR+
M-Duina 388

L Duino 388
M-Duino 42
M-Duino 42+
M-Duino SORRA+
M-Duing 53ARR+
M-Duino S4ARA+
M-Duing STAAR+
M-Duino S7R
M-Duina 57R+
M-Duino 58
M-Duino 58+

Get Board Info

Pragrammer: “Arduing Gemma~
Bum Boatioader

Also there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/
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5 How to connect PLC Arduino to PC
- Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino Family

- Select the correct M-Duino Board:
M-Duino 38AR+

@ sketch aug23a | Arduing 189 - o x
File Edit Sketch Toals Help
Auta Format ansT
Aschive Sketch
shet Fix Encoding & Reload
Manage Libraries. CtrloShifts1 =
Serial Monitor Curl+Shift+M
Serial Plotter Crrl=ShiftsL

WIFi101 / WIFININA Firmware Updater

¢yl Boara:w-Duino famity »
Model: "M Duino 38R +* §  M-Duino 198
“ s M-Duinc 19R=
‘Get Board Info M-Duino 21
Pragrammer: “Arduino Gemma® 3 LEL ok
e [# M-Duina 3848
M-Duino 38R
M-Duino 38R+
M-Duino 42
M-Duino 42+

M-Duina SORRA+
M-Duino 53ARR+
M-Duino S4ARA+
M-Duino STAAR~
M-Duino S7R
M-Duino 57R+
M-Duino 58
M-Duino 58+

- Select correct port.

&9 sketch_auglda | Arduino 1.8.9
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_augl4{ Fix Encoding & Reload
vold setup (] Manage Libraries... Ctrl+Shift+
/4 PUT YOl serial Monitor Ctrl+ Shift+ M
Serial Plotter Ctrl+Shift+L

WiFi101 / WiFiNINA Firmware Updater
void loop ()

/{ put yoi Board: "M-Duine WiFi/BT family" »
Medel: "M-Duine 19R+ WiFi/BT" >
}
Port ! Serial ports
Get Board Info COMT2 (Arduino/Genuino Mega or Mega 2560)
Programmer: "Arduino as ISP" >

Burn Bootloader



Ref. IS.MDUINO.38AR+ Rev. 1: 12-08-2020

6 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vvdc.

[——
u GND I

|—1I 24Voe |

| I

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: g
-12vdc / 24Vdc =

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

TR RE

protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 M-duino Family Pinout

7.1 A Zone connection

Base
(common unit)
A Zone
5 £
b= o
23 ° g
S 5 b
25 B 5
=0 < [
SCL 21 12C/SS
SDA 20 12C/SS
RX0 1 RX0/SS
TXO0 0 TXO0/SS
RX1 19 RX1/SS
TX1 18 TX1/SS
X 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51SI 51 SPI
SCK 52 SPI
Reset Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vdc Power Supply

Rev. 1: 12-08-2020

— 1

L] 1
R Configuration Switch* (see section 8 for
ARet . . A
saw configuring the communications.
I0Ref . . . .
3.3vde Enabling communications disables some
5vdc
Gnd I/Os)
SCL e
SDA
RX0
Tx0 ™
RX1 T . . .
L Communication Pins
T RS232]
7
Y+ Ea’.
& 88
At
Pin 3
50 SO
518l ]
52 SCK
Reset
5vdc
Pin2
GND
GND |53 Power supply connectors
R
2av |8 (24Vdc - GND)

% __

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

=

]

Base
(common unit)
A Zone
5 £
o
o "5‘ c
c o
= o % .%
o c S c
1 o - =1
=0 < [}
AREF AREF  |Arduino PIN
IOREF2 | IOREF2 |Arduino PIN
IOREF1 | IOREF1 |[Arduino PIN
7Vvdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc |Arduino PIN
GND GND GND
5Vvdc 5Vdc -
GND GND GND

OFF ON
SCL/I12.6
SDA/I25
Rx1/11.6
Tx1/11.5

Pin3/10.6
Pin2/10.5
D53(SD)
FD rs¢ss HD
O ON

NC

NC
RTC SCL
RTC SDA
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é 8
. %g z3 W
L] on I
- 4 <Ez\J P "
B i2 CE g e
§ < _Reser [ usB B Frogam | @ K2
E5 RTC Banery (CB#D) *uSD Socket[J
Ethernet Arduino / Power
Connector Reset button

USB programmer
connector

Autoreset

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)
B Zone
o & £
= o
8 o 5
A< 5 g
2 | 3 2
= 8 z 3
10.12 59 Analog/ Digital In
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55 Analog/ Digital In
10.7 54 Analog/ Digital In
(-)10.6/INT1 - GND 10.6
10.6/INT1% 3 Interrupt 1 In
(-)10.5/INTO - GND 10.5
10.5/INTO* 2 Interrupt O In
(-)I0.4 - GND 10.4
10.4 26 Digital Input
(-)10.3 - GND 10.3
10.3 25 Digital Input
(-)10.2 - GND 10.2
10.2 24 Digital Input
(-)I0.1 - GND 10.1
10.1 23 Digital Input
(-)10.0 - GND 10.0
10.0 22 Digital Input
Top Zone
O | o9 ] ogouw gAn I it oen | —
Led indicator I/Os state
B Zone
25 c
5| ¢ 5
ac e I3]
=5 3 s
o
o = T
<
GND GND GND
A0.7* 6 Analog Out
A0.6* 5 Analog Out
A0.5t 4 Analog Out
Q/Vvdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND
QO0.7* 6 Digital/PWM Out
QO0.6! 5 Digital/PWM Out
Q0.5 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Out

—afTo—
Analog:
0-10Vdc
Digital
5- 24vdc
Digital-

5 - 24vVdc

GND— |

10.12 —fT¥
10.11 —ofTs
10.10 —efi¥
0.9 —effo
0.8 —ofT%
0.7 —off¥
() 10.6/NT 1
10 6ANT 1<
(<) 10.5ANTDY
10.5/INT0="

()10.4—
04
(-)10.3—
03 o
(-)10.2—
02 o
(-}10.1—
01 o
(-)10.0—
0.0 o

OM: DIGITAL
OFF: ANALOG

Ja
2 Analog:
0-10Vde
—Bigtar
Q/vde

C§ Digital/PWM

Q/vde

GND
AO.T

* Note: use correctly configuration for

use this signal
(see user guide)

Rev. 1: 12-08-2020

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

1 See section 8 to select suitable switch configuration for enable these connections.
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7.3 C Zone (Relay Shield)

C Zone
o5 | £ L '
= E Dc; c
> c K] R1.8
I | 3 g
Q ]
= 8 z 3
R1.7
R1.8 42 Relay Out
R1.7 43 Relay Out
RL6 44 Relay Out R16 Relay Outputs
R1.5 45 Relay Out
R1.4 29 Relay Out
Al.2t 11 Analog Out R15
Al.1t 10 Analog Out
Al.0t 8 Analog Out
GND GND GND R4
Q1.2t 11 Digital/PWM Out i &
Q1.1 10 Digital/PWM Out Analog.
Q1.0t 8 Digital/PWM Out M@_
GNDCOM - External Isolated Out GND Digitalpim: ;
24VCOM - External Isolated Out Vdc Analc'>g OquUt (Switch
% Configuration)
Digital/PWM Outputs
Top Zone ; (isolated)
. I
Led indicator I/Os state :
es < R12 RELAY Outputs
50 o S
ag o B
v c
E c ‘5 c
5] =] R1.1
(@] B L —d(De—
< Analog:
0-10vdc
R1.3 30 Relay Out Digital:
R1.2 27 Relay Out 9-24vde
R1.1 28 Relay Out Eﬁ-ta\'
GND | GND GND o e
11.5 63 Analog/Digital Input — &nD
11.4 62 Analog/Digital Input - 15 .
11.3 61 Analog/Digital Input e 114 Analog/Digital Inputs
11.2 60 Analog/Digital Input 2 :1 g
11.1t 19 Interrupt 1 In El .
i1l ) GNDpIO.l 2 E'ﬁ ({;|111 Interrupt Inputs (isolated)
1.0t 18 Interrupt O In 3 i)
(L0 - GND 10.0 g 5 Configuration Switch*
-] @ .
;_% ES ;;S: 2102 (see section 8 to select correct
4wy .02 ) .
Pry Stlais configuration for outputs).
H 238

See section 8 to select suitable switch configuration for enable these connections.
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8 Switch Configuration

8.1 A Zone: Communications

LEFT ZONE
Switch
ON OFF
C ZONE
RX1/11.6 11.1 RX1
TX1/11.5 11.0 X1
B ZONE
Pin 3/10.6 10.1 Pin 3
Pin 2/10.5 10.0 Pin 2
uSD & RS-485
D53(SD) - SD
FD RS-485 HD HD FD
OFF ON
SCL/NC
SDA/NC
Rx1/11.1
Tx1/11.0
Pin3/10.6
' Pin2 /10.5
D53(SD)
o FD RS485 HD
OFF ON

4.SCL/12.1: ALWAYS AT OFF POSITION. On the MDUINO PLC ARDUINO ETHERNET 38AR I/Os
ANALOG/DIGITAL PLUS Controller this switch is not connected.

3. SDA/I12.0: ALWAYS AT OFF POSITION. On the MDUINO PLC ARDUINO ETHERNET 38AR I/Os
ANALOG/DIGITAL PLUS Controller this switch is not connected.

2. RX1/11.1: Choosing between RX1 or the input I1.6. If this switch is ON, it enables the 11.6
input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6.

1. TX1/11.0: Choosing between TX1 or the input I1.5. If this switch is ON, it enables the 11.5
input and disables the TX1. If this switch is OFF, it enables TX1 and disables 11.5.
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4. Pin 3/10.1: Choosing between Pin 3 or the input 10.1. If this switch is ON, it enables the 10.1
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.1.

3. Pin 2/10.0: Choosing between Pin 2 or the input 10.0. If this switch is ON, it enables the 10.0
input and disables the Pin 2. If this switch is OFF, it enables Pin 3 and disables 10.0

2. D53(SD): ALWAYS AT OFF POSITION. Switch has to be OFF position to enable the Chip
Select of the microSD card, never ON because in this position is NC (Not Connected).

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables
HD.

LEFT ZONE OFF ON
SWI\:'I(':CH ON OFF NG NC
N - - NC NC
RTC SCL RTC - RTC SCL
RTC SDA RTC - RTC SDA

1. RTC SDA: This switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,

whereas if it is in OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter
if it is in ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter
if it is in ON mode or OFF mode.
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8.2 B Zone Switches

B ZONE
SWITCH | ON | OFF
NC - -
Q0.2 Q0.2 | AO.2
Q0.1 Q0.1 | A0.1
Q0.0 Q0.0 | A0.O

o| NC
Zz9| Q0.2
=<
9z| o1
| Q0.0
[N

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QO0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A0.X, being X any number of the tables above.

8.3 C Zone Switches

CZONE
SWITCH | ON | OFF
NC - -
Ql.7 Ql.7 | Al1.7
Ql.6 Ql.6 | Al1.6
Ql.5 Ql.5 | Al15

9 NC
92| ats
sl Q15
o0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q1.X, being X any number of the tables above.
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If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A1.X, being X any number of the tables above.

9 M-Duino Arduino I/0Os 5V pins

The MDUINO PLC ARDUINO ETHERNET 38AR 1I/Os ANALOG/DIGITAL PLUS has some of the
Mega board pins available. These pins can be programmed according to Arduino features such
as |/Os operating at 5V or any additional features present in the pins (for example 12C
communication in pins SCL and SDA). As these pins are directly connected to the Arduino Mega
board they are not as well protect as the normal inputs. These pins are mainly meant to be
used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
RX1 19 Communication switch OFF
TX1 18 Communication switch OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

*IMPORTANT: 12.5 & 12.6 are not pull-up inputs although they are referred to the 12C pins
(switch configuration). There is a “reverse pull-up circuit “that is established in order to have
the same behaviour as the other inputs.
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9.2  Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.3 Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. The RX1/TX1 pins will only be available if
the switch configuration is in OFF position. If not using the Serial 1 interface these pins can
work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.4  SPI- MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.

9.5 Pin2/Pin3

These pins are only referred to the inputs 10.0/10.1. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external pull-
up or pull-down circuit could be set.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 8). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 I2C

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is established by default in
these pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up inputs.
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10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. The MISO, MOSI
and CLOCK pins are the same for all the connected devices, while the SS pin, conversely, will be
unique for each one.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins O
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

In order to use the TTL pins the configurations of the switches have to be the following one:

Switch Analog Shield Relay Shield
ON | OFF ON | OFF
CZONE
RX1/11.6 11.6 RX1 11.1 RX1
TX1/11.5 11.5 TX1 11.0 TX1

If the switches RX1/11.6(11.1) & TX1/11.5(11.0) are in OFF mode, the RX1/TX1 will be enabled. In
order to use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).

33




Ref. IS.MDUINO.38AR+ Rev. 1: 12-08-2020

10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
EE - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL RTC : Arduino won’t communicate with the RTC.
RTC SDA RTC -

12C must be enabled in order to communicate with the RTC. See section 11 12C to enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the micro SD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the micro SD
can’t be used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.
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£
y ! Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.
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11 Instructions for interconnection between Industrial Shields

controllers

11.1 RS-232 Communication:

M-Duino 38AR
I/0s PLUS

KRFC-5 Ferrite (4 Loops)

Tx

SHIELDED CABLE
Fernte KITA
GND
12/24v

<

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

-~ -

M-Duino 38AR -
I10s PLUS

KRFC-6 Ferrite (4 Loops)

A -

SHIELDED CABLE
Ferrite KITA
GND |
12/24V

<’

11.2.2 Full Duplex

M-Duino 38AR

“_Another Industrial

“ Another Industrial
| Shields PLC

X peom

Ferrite KITA

\

A e B

Shields PLC

RS-485

Ferrite KITA

\

*_Another Industrial
I/0Os PLUS Shields PLC
KRFC-B Ferrites (4 Loops)
A A
B B
RS5-485 v v RS-485
z z
Ferrite KIT SHIELDED CA Ferite KITA
GND . SHIELDED CABLES i
vy XX FH OO
] / \
< S N e SR

GND
1224V

GND
12/24V

GND
12724V
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11.3 Ethernet

KRFC-& Ferrite

Rev. 1: 12-08-2020

—L —‘J - - Ethernet

M-Duino 38AR
I/10s PLUS

Ferrite KITA

1oy SOOI

i ,:@i} ,,,,,,,,,,, emel LTI

~_Another Industrial

Shields PLC

Ferrite KITA

—. ~ GND
12724V

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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12 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

Rev. 1: 12-08-2020

(,fmfﬂ ISOLATED INPUT \

&
&

GND
Sharzev

‘] (100

o/,c;jﬁ.ﬁ

SHIELDED CABLE

Ferrite KITA

@l

i

SHIELDED CABLE

/ Dowrdoad e MDUND LAYOUT:
From®

I — S

P — .

Ferrite KITA

1y

— POWER

B oomawm

SHIELDED CABLE .|| Duumlon s MOURO LAVOUT:
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SHIELDED CABLE
2124V o

Ferrite KITA
0

=8

Rev. 1: 12-08-2020

0.7

SHIELDED CABLE Fromt wamdvesAS o \
< mt U

0-10v

SR,

Ferrite KITA

\J

224V

0.7

SHIELDED CABLE L}:“w \
S—"
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SHIELDED CABLE %%
51224V S,
GND
Ferrite KITA
GND
ol

12/24V

Ferrite KITA

o

Y

B owemuour

10.7

(3
SHIELDED CABLE J Downioed Sre MOUINO LAYOUT:
From: www industrisishiwids. com \
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SHIELDED CABLE

) "‘i‘”j@a

L

ALWAYS
CONNECTED

SHIELDED CABLEf Pty drussentt felipocd \_

&

VOUT = @/ Vde
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SHIELDED CABLE

Ferrite KIT/ ®
GND VOUT = 0/ Vde
m{ﬁ

SHIELDED CABLE

DIGITAL / PWM ISOLATED
OUTPUT

* Sow the swilch
configutarion (ON)
Qivde H- 51224V
COM {-) { GND .&
J ALWAYS
JU1 CONNECTED
Ferrite KITA Q0.8 ® SHIELDED CABLE
f: POWER VOUT = Q/ Vide
"'L; I DIGITALFWA OUT

SHIELDED Cﬁﬂlﬂﬂ L e
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* Soo the switch
configutarion (ON)
Q/Vde
COM (=) gﬁw
Jn CONNECTED
Ferrite KITA 05 @
B Mﬁ] VOUT = Q/ Vide
224V DAGETALPWA OUT
SHIELDED ASL;/—ELT%
\J y
SHIELDED CABLE
—
(/_:uuoeou-rpur )
\I * Analog Outs no led r’f
indlicator
S B * See the switch
1[0 g Olos configutarion (OFF)
M.ii[{;u GND =
@3/0 g O| 02 AO5 E‘—” “'W)
g
ME SHIELDED CABLE
NCiOD O WI!/
Ferrite KITA —ia o
GND
= 9) |} power
20N | 8 ANALOG OUT
SHIELDED CABLE Dowibad o MOMOLAOUT: |
/ e
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension :

101

129
114

- DIN Rail mounting

Profilato a cappello TH 35-7,5 Profilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 5
153,
1004
15°
RO8
R12
RO8
2] 7
= el 12004
Sezione A / Section A k12
~ 22 min. finoa / To 2,5 max
H
= Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNMA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PCU/ABS METHOD PUABS
Mecconiche  Resishiza k ISTH D638 WPo I} Mechanical fest Resisonce o tensi sess of vied ASTHD638 MRy 8
Resigheo o tazioneo ity KTAD638 WPy 8 Tongloshength ASTMD638 MRy 4
Alsngomerto o ot KT8 % 59 Uimonte o ASTMD638 % 59
Mool in fesione KSTHDTH  MPo 2694 Pleing modules ASTADTS0 MRy 289
Povo 120d coninogli 5018004 Xy 55 rod st otched 15016014 Y/’ 55
Termiche Temp. di g limento Viat, medo B ASTM 01525 °C 14 Thermal fest Vit sodtening tomperctre method B ASTMDIS2S (. 14
Jomperatvm Riatio 1 81 My KOG °C 9 Rebeoting temperctue 1,81 MPg ASTMDSE 9
Fisiche Peso adfio KSR gém3 Wil Physical test  Specfc guviy ASTHOT)  giand 12
Riti nell KTHD9SS % 0406 Mould hrivkage ASTIDISS % 0406
Mk Flow Index 260°C - 98N KTHDIE g0 11 el Flow Indes 260°C - 98N ASTMDI238 10" 11
Comportamento Aukesinguerza (i di pesor) IV - V-0(08) Flame test Self ainguisher (thidkness in mm) Uis4 - V-0(08)
ollo fiomma i Iocondescen 37 mm 89521 °C 960 Incondescents threod 37 mm 169521 °C 960
Inaltronic si riserva il diritto di modificore il moterile con cui realizzo i propri prodotti Itoltronic con operate ony change of the motericls without being obliged to forewam.
senzo obbligo di preawiso.

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 38AR 1/Os PLUS from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 38AR I/Os PLUS. When configuring the layout of the M-Duino 38AR 1/Os PLUS
inside your panel, consider the heat-generating devices and locate the electronic-type
devices in the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and high-
energy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring M-Duino 38AR 1/Os PLUS. Is designed
for natural convection cooling. For proper cooling, you must provide a clearance of at least
25 mm above and below the devices. Also, allow at least 25 mm of depth between the
front of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential for the satisfactory operation
of solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquefied capacitors) must be disposed
of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Rev. 1: 12-08-2020

Revision Number Date Changes
0 30/08/2019 First implementation
1 12/08/2020 Correction of technical details
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev. 1: 12-08-2020
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